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Document Style Sheet (for the section header, use
“  Section Header”)

1. Creating Content (for the subsection header, use “
Heading 17)

1.1 Writing content for the document. (Use © Heading 2” here.)

The correct font to use for all written content is Avenir Next LT Pro, available with Microsoft
Word. Allheadings and titles should use the Avenir Next LT Pro Demi font. To write content
for this document, be sure to set the textto©  Text,”located in the Styles option, above.
This will automatically format all text in the correct style. To find Styles (ifit is not already
visible), click on Home and look for Styles. It willbe located near or at the center ofthe
screen. Ifthe style needed (* Text”)is not shown in the menu, follow these steps to locate it
(use these same steps whenever it is necessary apply a style from the Styles option).

1. Click on the small arrow in the lower right-hand corner.

AaBbCcDc | AaBbCc Aah AaBbCcDc 1. Aal 1.1 Aal 1.1.1 Aa A4gBbCcDc [
T Normal VR Text TVRTitle TNoSpac.. Headingl Heading2 Heading3 Heading4%

Styles “
Figure 1: Style options group

2. Clickon Options, located on the bottom right ofthe pop-up window.

Styles MR
Clear All
Normal b i
[ rext 7]
litle b f
No Spacing b If
Heading 1 Ta
Heading 2 Ta
Heading 3 1a
Heading 4 13
Heading 5 Ta
Title 1a
Subtitle Ia
Subtle Emphasis a
Emphasis a
Intense Fmnhasis a

| Show Preview
| Disable Linked Styles

AJ ‘fq A/ Options...

Figure 2: Options for Styles interface
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3. Under Select styles to show, click the drop-down menu button.

Style Pane Options ? X

Select styles to show:
Recommended v
Select how list 1s sorted:
As Recommended v
Select formatting to show as styles:
] Paragraph level formatting
E] Font formatting
[[] Bullet and numbering formatting

Select how built-in style names are shown
Show next heading when previous level is used
[:] Hide built-in name when alternate name exists

@Onlyinthisdocument O New documents based on this template

=0 [ om

Figure 3: Style Pane Options interface

4. Select All styles and click OK.

-~
X

Style Pane Options

Select styles to show:
Recommended

In use
In current document
All styles

("] Font formatting
[] Bullet and numbering formatting

Select how built-in style names are shown
Show next heading when previous level is used
D Hide built-in name when alternate name exists

@ Only in this document O New documents based on this template

o -

Figure 4: Style Pane Options drop-down menu
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5. Search for and select the style needed, then click on X.

Styles AR
Clear All
Normal T

[ ﬁ

litle T

No Spacing T
Heading 1 13
Heading 2 Ta
Heading 3 a
Heading 4 f1a
Heading 5 f1a
Title Ta
Subtitle Ta
Subtle Emphasis a
Emphasis a
Intense Fmnhasis a

|| Show Preview

["] Disable Linked Styles

AJ [7a] [A ]| optons..

Figure 5: Choosing the correct style

Ifthe font size, color, and/or other formatting are incorrect, simplyclick®  Text”in the Styles
interface to restore the correct formatting.

1.2 Formatting the title page
Use the default title page which comes with this document, including the large

The title and date fields have been formatting as Document property fields,
which help to organize the document within the responsible department’s
SharePoint page. Click on the appropriate field to input the document’s title and the most
recent publish date. The version field is nota document property field; please include the
most recent version, using "style guide for formatting. *

2Title |

[Title]

Doc Version | [Publish Date]

Document title goes here...

Doc Version | [Fublish Date]

Document title goes hara....
Doc Version ||June 8, 2022

Document title goes here...

Updated version information goes here | 6/8/2022

Figure 6: Adding the cover page information

*More information to come about how to correctly style the document version.
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When editing the title or the publish date, do not delete the entire phrase. This willremove
the document property format. Instead, click within the title or date, hit backspace and/or
delete, and the document property box willappear. Edit the necessary mformation and click
out ofthe box. Please note that entering the Title and Publish Date on the title page will
automatically update the Title within the header and the Publish Date within the footer of
the document.

1.3 Branding

Only use the updated branding, including logos, color schemes, and design
guidelines. To find the latest branding, including any logos which are included by default
with this template, please visit "Canto page at canto.com. This
template includes, by default, a custom Theme, which is found under the Design tab, where
the following should be located:

L A sanraqmph Specing ~ I
= . ina~ Effects v
‘ A =7 Parograph Spacing Colors | Fonts @l Wal
o5 Ijin‘ccc“ - 1} OSctas Default

olqrs |

Fonts

. © ault
Set as Defou o

Custom
[T | Voo Custom A Avenir Next LT Pro
< |

Avenir Naxt LT Pro

Figure 7: Design tab interface

The colors are from the Style Guide, available via Cantos.

1.4 Formatting content

Begin paragraphs on the left margin, leaving a single space between paragraphs. The
preferred order ofemphasis is to start with bold and then move to italics. Use quotation
marks only around instances ofdirect quotes. Please see the following on how to include
quotation marks within the document.

Forexample, here’s a look at changing values in . When demonstrating to
readers the field where they should make adjustments or buttons they should click, write the
field/button in bold and suggested field mput text within quotations:

To change the date and time in the fields. click within the imput box and
add a date in numerical form, such as “06/05/22.” Hit Tab and add the time desired
for the to start using 12-hour format, such as “05:55 PM.” Do the same for
the fields. Once the correct dates and times are input, click Update.

Figure 8: Interface
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1.5 Adding Images
To add images, use the following procedure. It will help ensure that when the document is
exported as a PDF file, allimages and their layered parts willremain as intended.

First: go to Draw and click Drawing Canvas.

File Home lns}' Draw Design Layout References Mailings Review View Help Acrobat

e i
%{,%llllg & || D
\.‘_:,(:_\ ' ' v Lo+ Inkto Inkto | Drawing Ink
Shape ﬂ/Canvas Replay
Drawing Tools Cl Insert Replay
Figure 9: Draw interface

This willopen a box on the page where the cursor is located.

Next: with the Drawing Canvas selected, go to Insert and select Pictures. Choose where the
image is located, whetheritis on the local device, is located online, or is a stock image. Insert
the image ofchoice. Note that the image can only be as large as the canvas, so adjust the
canvas’s size as needed. Within the canvas, add pictures, shapes, and icons. Ensure that they
are within the borders ofthe canvas, which should show as selected. Below, the selected
canvas and the selected image both have their sizing handles visible.

/O o ? 7
Drawing canvas
selected
o o}
Stock image
from Word
O O O

Figure 10: Drawing Canvas example

Layering images within the canvas will ensure, as noted before, that images will publish as
intended when exported as a PDF file. The canvas also allows users to move images around
freely within the borders, instead ofdealing with the limitations of Word image placement.
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Figure 11:Iayered images in a canvas, selected for visibility

[Title ]

When the graphic has been designed to suit what’s needed, be sure to reduce the size ofthe
canvas close to the size ofthe graphic to prevent unwanted blank areas. Leave a small buffer
to make it easy for edits to be made, ifnecessary. Ensure that the image is centered on the

page to help visually guide the eye ofthe reader to the graphic and to make it stand out from

the surrounding text.

Finally: when the graphic is complete, right click on the drawing canvas and select Insert

Caption.

@
i)

Cut
Copy

Paste Options:

A=

Changg Picture

Bring to Front

Send to Back
Link

Save as Picture...

82

& i

Figure 12: Right-click image interface

Insert Caption...
Wrap Text
Edit Alt Text...

Size and Position...

Format Picture...
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Each image should be given a short, descriptive label, following the format “Figure
[number][colon] [description].” Add it to the Caption: mput box and click OK.

Caption

camiom/

Figure 10: Right-click image interface

Options
Label: Figure v
Position:  Below selected item v

:] Exclude label from caption
New Label.. Delete Label Nymbering...

e

Figure 13: Caption interface

Ifthe caption shows up in Word’s default formatting, simplyclick® Caption”in the Styles
interface, using the procedure outlined above. and the caption will display correctly. Be sure
to center the caption below the image, which should also be centered.

1.6 Using Layers to llustrate Graphics
a¥0 , 02904, o0V
040 © Co® Sopo®

alo .. .a% . .o%
OTEo© ®To® STpo®

9g° o°

Figure 14: Individually selectable pointers and numbers

Use the above number pointers or numbers to illustrate the correct order to operations on a
graphic. Each ofthe above pointers and numbers are individually selectable and can be
copied and pasted into a different drawing canvas. Resize as needed.
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The drawing canvas allows for easy layering ofnumbers, pointers, and arrows to illustrate the
order ofoperations for a given process. Ensure that the correct drawing canvas is selected as
active. To find the arrows, go to Insert and click on Shapes. Under Lines, chose the arrow:

Recently Used Shapes

ENNOOCOALTLIG
e\ { } %

Lines
TSS\\1LL222\0Y

Rectangles
OoDLoatOOoOoa

Figure 15: Shapes interface

To correctly format the arrow, make sure it is selected. Click on Shape Format, which will
become visible at the end ofthe tab line in blue, above.

Review View Help Acrobat Shape Format
= |&= 3= 4] IEI P o )
HQBDC.C AaBbCcDe 1 . AC

=B 5|5
= = e, LA T Normal TVR Capti... TVR Heac

Figure 16: Shape Format interface

In the Shape Styles options, click on Shape Outline.

.gj.

NN NN al

¥ | & Shape Effects v

Shape Styles

Figure 17: Shape Styles interface
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Next, choose red from the Theme Colors and line Weight size 2% pt.

Theme Colors
= llllll/

Standard Colors 1
an fEEEEE

No Outline ;
More Outline Colors... 7
= Weight > vpt
- Y pt
== Dashes > Y pt
=, Arrows > Tpt

----- More Lines...

Figure 18: Choosing the correct Color and Weight

1.7 Iayering Rectangles and More on an Image
To draw a rectangle on the graphic, choose Rectangle: Rounded Corners, which is located
second from the left under Rectangles. Follow the instructions for the arrow, above, for the

color and line weight.

Recently Used Shapes

n\\mo$§11w06'§
ey } -

Lines
WNNLLAL2.E 3 VB

Rectangles
O0DOAOOO0O0O0a

Rectangle: Rounded Corners

AN

Figure 19: Rectangle interface

Under Shape Fill. be sure to choose No Fill for the interior ofthe rectangle so that the
graphic is not obscured. Locate this in Shape Styles when the rectangle is selected and
Shape Format visible.

Confidential and Proprietary. Distribution prohibited. [Publish Date |
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Follow these steps for additional shapes; however, note that the rounded rectangle, the
arrow, and the supplied numbers and pointers are preferred.

To add text to an image. click on Insert, Shapes. and under Basic Shapes, chose Text Box.

Basic Shapes

_—EOANOIOLOOQOOB®
@GOo0LI L0000
ST

Figure 20: A small square with a letter in the center

Position and size the text box where needed.

O

J

(? o
Figure 21: Atext boxbeing drawn

For the font, use Avenir Next LT Pro Demi, size 11, in red. With the text box selected,
use Shape Format -> Shape Styles and select No Fill and No Outline. Do not use a
background on the text unless necessary; ifnecessary, be sure to use the style sheet
available on Canto for guidance on colors.

2. Additional Formatting Styles

This section will cover tables. bulleted and numbered lists, headers and footers. table of
contents, and any remaining style issues.

2.1 Bulleted Lists
For bulleted lists, use Word’s de fault style, as seen here:

e The primarybullet should be the solid black dot.
o The secondarybullet (hit Tab) should be the outlined dot.
* The tertiary bullet should be the solid square.

e Etc.

Confidential and Proprietary. Distribution prohibited. [Publish Date ]
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e Repeatedly hitting Enter will re turn to an earlier bullet tab.

o Avoid going more than one tabbed bullet per sub-bulleted section.

2.2 Numbered Lists
Use Word’s default style for numbered lists but follow these steps to make the primary
numbers bold:

Under the Home tab, go to the Paragraph group and click on the down arrow next to the
miniature numbered list.

¢l

Paragraph
Figure 22: Numbered list interface

At the bottom ofthe pop-up window, select Define New Number Format...

Document Number Formats

1. a. i
2 b. ii
3 C. jii
1.
2.
3.

Define New Number Format...

Figure 23: Defining the new list

Confidential and Proprietary. Distribution prohibited. [Publish Date ]
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In the next window which pops up. click on Font....

Define New Number Format ? X

Number format
Number style:
p [y - - b d

Number format:

6.
Alignment:
Left v

Preview

Figure 24: Define options

In the font selection window, choose Avenir Next LT Pro. font size Bold. and size 11.

Font ? X
Font Advyanced

Eont Font style: Size:
Avenir Next LT Pro Bold 1
Athltlf_xtrallght A | | R.e*guisr | '8 A
\Athiti Light | Italic 9
| Athiti Medium | 10
| Athiti SemiBold Bold halic
| Avenir Next LT Pro Vi 12 v
Font color: Underline style: Underline color:

No Color iy i MNo Color o

Fife cau
Figure 25: Selecting font options
Confidential and Proprietary. Distribution prohibited. [Publish Date |
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The new font style willbecome part ofthe Numbering Library, making it easy to select.

Numbering Library

1)
2)
3)

None

Figure 26: Located in the numbered list window.
Follow these numbered list best practices:
1. Make sure allnumbered lists start with one
a. Tabs within numbered lists follow traditional outline style conventions

1. Theywill alternate between numbers, the alphabet, and Roman
numerals.

1. Etc.
2. As with bulleted lists, hitting Enter will return to an earlier number tab.

a. Avoid going more than one tabbed number per sub-numbered section.

2.3 Creating Tables

Tables should use the following style. The header should have a light gray background (hex
code #E8F1F2), while the remainder should have a white background. Use Avenir Next LT
Pro for the font. Content should wrap to the next line to avoid changing column sizes. All
tables must fit within a single page. For the header, center the column titles both vertically
and horizontally. For the content rows, center the text horizontally and align along the bottom
vertically, unless the cell covers two or more rows; in those instances, center the text within
the cellboth horizontally and vertically. Center the table on the page byright-clicking on it.
Select Table Properties... and under the Table tab. look for Alignment and choose Center.

Table Title (size 10 font). Example Table text.

Split Columns Example
Column 1 Column 2
One Two
Row 1 Sample text with
wraparound
Row 2
Example Table notes.
Confidential and Proprietary. Distribution prohibited. [Publish Date ]
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2.4 Creating Checklists

Ifthe document needs a checklist, please observe the following:

Use Avenir Next LT Pro for the font.

Avoid going smaller than font size 10, if possible.

Keep the checklist confined to a single page. ifpossible.
Set up the checklist using Word’s bullet functionality.

Using Define New Bullet, follow these steps if the open square is not already available as a
choice:

— — — —_— — ?
—li=. '=. |= 5= Ql q Define New Bullet ? X
o — — — —
I Bullet character
=i T= R S R [ symbol.. e =
- - Alignment: %

Left e

ooooao

Paragraph

Eri=- - == 481 1| |asBbe

Recently Used Bullets

el

Preview

® .
Bullet Library
\/ oK I Cancel
Jlello][=][ ][] — |
Symbol ? ¥
A
L i ‘EontVWingdmgs ,v
Document Bullets " OOO@O - +* * *’*A
%+ |+ x|olox|o|dw|ooc]o]o]o
=L BRI EES AR
= . IR ggR@am < - |47 e[s/0lo«
Define New Bullet... SIMVIRIZAK|N €DV RIAK N e
21 3| || Ayl x| v EM A,

Recently used symbok:
O|+|0[o[€]£]¥[0]® ™ «]2|<|=]+]x

Unicode name:

Wingdings: 168 Character code; 168 k3 Symbol (decimal)  ~
- o ] o

Figure 27: Define New Bullet interface

Each new area ofthe checklist should be signified by a return to the left margin:

O End each area line with a colon (:). as above.
o Foradditional information, hit Tab for a secondary bullet point.

2.5 Updating Headers and Footers

Much ofthe information within the headers and footers willnot change or willbe updated
automatically when the Document Property fields are used on the title page. However, the
“Document Version” within the header willneed to be updated with the correct version. Also
make sure that the copyright year (footer) matches the current year. Double click within the

Confidential and Proprietary. Distribution prohibited. [Publish Date ]
©2022, Page 17 of21



Document Version [Title ]

header field to begin editing it. Please ensure that both the document version and the
copyright year are current. To exit the header & footer fields, click on Close Header and
Footer:

Header & Footer

&5 Header from Top: 0.4 N X
E, Footer from Bottom: 0.4" .
Close Header
E Insert Alignment Tab and Footer
Position Close

Figure 28: Closing Header & Footer

Within the footer, at the bottom right-hand corner, is “Page [x] of[y].” While [x]updates
automatically, [y] willneed to be updated. Double click on the footer and right click on [y].
Select Update Field and close the footer:

Page 11 of 1&

@

r_ﬁD Paste Options:

22 5 [ [A

[Title] [ Update Field

Edit Field...
Ipdated Toggle Field Codes
ever, you
1 the A Eont..
the heade

:__q[ Paragraph...

1 Close
Figure 29: Updating Page [x] of[y]

2.6 Updating the Table of Contents

The document should include a table ofcontents (TOC) to assist the reader in finding what
theyneed. This field is automatically generated and included as part ofthe document, but
forcing an update is necessary so that it remains current.

Confidential and Proprietary. Distribution prohibited. [Publish Date ]
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First, click on the TOC. This will outline the field, indicating thatit’s being edited. Click on
Update Table...

I A ~ [ update Table...|

Contents \ 1=
Document Revisidn HIistorny......cuini.

REQUIREMENTS.....cevirimimimiisissssssssssssssssasasissssssssssssesees

1. INStallation ... s
11T
1.2

2. Internal Network Requirements..........cocuvuvererareraeseinns
21

Figure 30: TOC interface
Next, there willbe two options: Update page numbers only and Update entire table.

Choose Update page numbers only ifthe sections and subsections are all the same and only
the page count has changed.

Choose Update entire table ifany sections/subsections have been added, changed, or
deleted. Click OKand the table willbe updated.

I @ ~ [l update Table...l i@ - [9) Update Table...
Contents | Contents
(= D —e Lo o + D Dosh W T
. Update Table of Contents ? X [ 3 Update Table of Contents ? X l
1 Word is updating the table of contents. Select one of the 1 Word is updating the table of contents. Select one of the

following options: / " following options:
(® Update page numbers only E O Update page numbe:y
(j) Update entire table (@ JUpdate entire table’

: o] oo 5] o

2.71 ¥ i |

WS}

Figure 31: Updating the TOC

2.7 Starting a New Page

Start a new page only when necessary, such as starting a new section (for example, going
from Section 2 to Section 3, but not from subsection 2.1 to subsection 2.2). When starting a
new page within the document, avoid hitting Enter until the new page appears. Instead, best
practices are to use Page Break, found under the Insert tab. For PCs, the keyboard shortcut is
Ctrl+Enter. In Macs, use Command+Return. Using this allows the new page to remain as
intended, even ifpages of content are added prior to it.
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2.8 Informational [conography

Throughout documentation, Warnings, Cautions, and Notes are used to draw
attention to important information in the body ofthe text. It is important to pay attention to
the content provided under these headings. Use the following graphics. Copy and paste the
appropriate iconography and accompanying text; edit the text to reflect the needed
information. It should be centered on the page, indented on both the left and the right sides
to draw attention to it.

A WARNING: This symbolindicates a hazard that could cause death,
serious personal injury or electrical shock.

CAUTION: This symbolindicates a hazard that could result in
property damage.

@ Note: This symbolindicates additional information about a subject.

Tip: Usage and best practice advice.

3. Template Status
This template should be considered a living document with frequent updates, so check
frequently to make sure the latest style sheets are in use.

3.1 To Begin

To begin using this document, delete the instructions, above. Ablank template is included
below to ensure ease ofuse. Delete Sections 1 through 3; save the document in .docx format
using the File -=> Save As option, giving it a unique and readily identifiable name. Do not
delete the title, header, or footer.

Figure 32: Save As interface
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New Document Here

4. Section Title

Begin typing here. Please note that the actual content ofsections/subsections should be
adjusted to best suit your document’s needs: the following is included for ease ofuse.

Figure 33: A Surprised Bot

4.1 Subsection Title
e Bulletone
o Secondarybullet
= Tertiary bullet
1. Outline style (bold numbers)
a. Additional details
1. Details about the details

4.1.1 New Title Here
Table Title Here

Header Row Column Header Title Et Cetera
TableTextl Avenir Next LT Pro, size 9

Additional table information, ifneeded
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